This document is designed to help users become familiar with the Standard & Poor’s Research Insight software and the Compustat Global database. Consider the information contained herein to be a starting point. This document may be copied for use by current subscribers only. More complete documentation may be found both within the software and in the manual set (Getting Started, Beyond Basics, Report and Chart Library, and Data Guide) supplied with your subscription. Additional manuals may be ordered by contacting Standard & Poor’s Investment Services Client Services Center at 800-523-4534.

All information and data provided through university subscriptions is restricted to academic use only.
# Table of Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Overview</strong></td>
<td>2</td>
</tr>
<tr>
<td>Population and Pre-defined Sets</td>
<td></td>
</tr>
<tr>
<td><strong>Research Insight Workspace</strong></td>
<td>3</td>
</tr>
<tr>
<td><strong>Research Insight Help Features</strong></td>
<td>4</td>
</tr>
<tr>
<td>Help Menu (including software demo)</td>
<td></td>
</tr>
<tr>
<td>Look Up Tool</td>
<td></td>
</tr>
<tr>
<td><strong>Understanding Time Periods</strong></td>
<td>6</td>
</tr>
<tr>
<td>Current Period</td>
<td></td>
</tr>
<tr>
<td>Setting the cutoffs</td>
<td></td>
</tr>
<tr>
<td><strong>Time Period References</strong></td>
<td>7</td>
</tr>
<tr>
<td>Absolute, Relative and Calendar time referencing</td>
<td></td>
</tr>
<tr>
<td>Specifying in Reports, Screens and Formulas</td>
<td></td>
</tr>
<tr>
<td><strong>Functions Overview</strong></td>
<td>9</td>
</tr>
<tr>
<td>Calculating Statistics Across Sets</td>
<td></td>
</tr>
<tr>
<td><strong>Formulas Overview</strong></td>
<td>10</td>
</tr>
<tr>
<td>Formula Examples (examples of logic and syntax)</td>
<td></td>
</tr>
<tr>
<td><strong>Currency Translation</strong></td>
<td>13</td>
</tr>
<tr>
<td><strong>Screening Overview</strong></td>
<td>15</td>
</tr>
<tr>
<td>Defining Criteria</td>
<td></td>
</tr>
<tr>
<td>Viewing Results and Saving Sets</td>
<td></td>
</tr>
<tr>
<td><strong>Importing Company Sets</strong></td>
<td>16</td>
</tr>
<tr>
<td><strong>Report Overview</strong> (Generating Data)</td>
<td>17</td>
</tr>
<tr>
<td>Pre-Defined Report</td>
<td></td>
</tr>
<tr>
<td>Screen Association</td>
<td></td>
</tr>
<tr>
<td>Exporting/Saving</td>
<td></td>
</tr>
<tr>
<td>Accessing in Microsoft Excel®</td>
<td></td>
</tr>
<tr>
<td>Creating Reports / Report Assistant</td>
<td></td>
</tr>
<tr>
<td>Panel Reports for SAS (<strong>important for faculty &amp; research!</strong>)</td>
<td></td>
</tr>
</tbody>
</table>

THE “Θ” SYMBOL AT THE BOTTOM OF EACH PAGE PROVIDES A LINK BACK TO THIS TABLE OF CONTENTS
Overview

Welcome to Standard & Poor’s Research Insight!

Standard & Poor’s Investment Services, a division of The McGraw-Hill Companies, produces a variety of software and database products for institutional, financial, corporate and academic clients. Research Insight is a powerful yet easy-to-use graphical interface to the renowned Standard & Poor’s COMPSTAT® database(s), providing users an efficient means of conducting research via data queries, retrieval, manipulation and analysis. Standard & Poor’s data and software are used commercially by money managers, investment banks, consulting and accounting firms, government agencies and corporations.

The Compustat Global database contains fundamental financial and market information, and provides extensive coverage of the world marketplace. The database contains detailed information for approximately 15,000 companies from 70 countries representing Europe, Asia, the Pacific Rim, the Americas, Africa, and the Middle East, along with a wealth of market data for local market indexes and world currencies. Your subscription helps you take full advantage of today's dynamic, worldwide marketplace and provides you with critical financial information on a wide range of industrial, insurance, banking, and other financial services companies.

The wealth of useful market data includes market indexes and index constituents, monthly price histories, and dividends. Financial information includes detailed income statements, balance sheets, cash flow and supplementary data. Research Insight (Global) allows you to perform rapid cross-border analyses on any data or ratios you choose, including Currency files with cross-translation tables on more than 100 currencies; and Pricing data on more than 90 local market indexes.

Compustat Global data is collected using consistent sets of financial data items that are developed by examining financial statements from a variety of countries and identifying items that are widely reported by companies regardless of their geographic location, business activity or accounting practices. Within these uniform data sets, we normalize data according to local accounting principles, disclosure methods and data item definitions.

Data is carefully validated and consistently reported, utilizing ten international and industry formats. This allows for a highly detailed presentation of company fundamental data that take into account the various international accounting standards seen in the world today.

- Population and Pre-defined Sets

Research Insight has many different predefined sets for different types of data, referred to as dollar sign ( $ ) sets. The Compustat Global database contains unique predefined $ sets. Examples of some available $ sets are listed below:

Compustat Global Database

<table>
<thead>
<tr>
<th>$ Set</th>
<th>Description</th>
<th>What it contains...</th>
</tr>
</thead>
<tbody>
<tr>
<td>$G</td>
<td>GV Industrial Active</td>
<td>All active Industrial companies in the database</td>
</tr>
<tr>
<td>$F</td>
<td>GV Financial Active</td>
<td>All active Financial Services companies in the database</td>
</tr>
<tr>
<td>$D</td>
<td>GV Industrial Research</td>
<td>All inactive Industrial companies in the database</td>
</tr>
<tr>
<td>$X</td>
<td>GV Financial Research</td>
<td>All inactive Financial Services companies in the database</td>
</tr>
<tr>
<td>$L</td>
<td>GV Indexes - Active and Research</td>
<td>All active &amp; inactive Local Market Indexes in the database</td>
</tr>
<tr>
<td>$GI</td>
<td>GV Industrial Active Issue</td>
<td>All active Industrial Issues in the database</td>
</tr>
<tr>
<td>$FI</td>
<td>GV Financial Active Issue</td>
<td>All active Financial Services Issues in the database</td>
</tr>
<tr>
<td>$DI</td>
<td>GV Industrial Research Issue</td>
<td>All inactive Industrial Issues in the database</td>
</tr>
<tr>
<td>$XI</td>
<td>GV Financial Research Issue</td>
<td>All inactive Financial Services Issues in the database</td>
</tr>
<tr>
<td>$LI</td>
<td>GV Index Issue</td>
<td>All Local Market Index Issues in the database</td>
</tr>
<tr>
<td>$N</td>
<td>GV Currency</td>
<td>All currencies in the database</td>
</tr>
<tr>
<td>$GISP500</td>
<td>GV S&amp;P 500</td>
<td>All active companies in the S&amp;P 500</td>
</tr>
</tbody>
</table>
The Research Insight Workspace

- Welcome to Research Insight Window

The Welcome to Research Insight window is your entry to the basic functions of Standard & Poor’s Research Insight. When you click a button or corresponding text with your mouse, you will be taken to the many different functions of Research Insight. If you do not want this window to automatically display when you enter Research Insight, click the Display on Startup check box. Below are brief descriptions of each button on the Welcome to Research Insight window and sidebar:

**Research Insight Desktop**

This desktop provides another way to access all the features of Research Insight. It displays when you click Close from the Welcome window, or whenever you click Cancel in the Research Assistant. To return to the Welcome window click the (Welcome) button or select Welcome to Research Insight from the Help menu.

---

**The Research Assistant**

The Research Assistant is designed to walk you through screening the database. The Research Assistant can also link to other wizards in Research Insight to build reports or charts with the results of your database screen.

**The Report Assistant**

The Report Assistant is designed to walk you through building and running custom reports. Depending upon which report format you choose to work with, the Report Assistant can consist of up to three windows. It can be used as an extension of the Research Assistant to build a custom report with the results of your database screen or by itself with the aid of the Run Assistant as the method you use to screen the databases.

**The Chart Assistant**

The Chart Assistant is a wizard designed to walk you through building and running custom charts. Depending upon which type of custom chart you choose to work with, the Chart Assistant can consist of up to three windows. The Chart Assistant can be used as an extension of the Research Assistant to build a custom chart with the results of your database screen or by itself with the aid of the Run Assistant as the method you use to screen the database.
Research Insight Help Features

Throughout this document look for the symbol “◊◊”, which is used to identify tips or information of particular interest to users.

Take a minute to get acquainted with the Research Insight Help Menu (available via the HELP/Research Insight Help Topics menu option), learn how Help is organized, and discover some tips and short cuts to make your tasks easier.

- The Research Insight Help Menu

  Research Insight Help Topics
  Includes the Table of Contents, an Index, and Find (lets you search for a topic).

  Data and Reference Definitions

  Data Item Definitions
  Displays item and concept definitions for the selected database (Global)

  ◊◊ Note that you can “bookmark” frequently used data definitions as well as help topics and functions.

  Reference
  For COMPUSTAT GLOBAL topics include:
  Country of Incorporation Codes; Exchange Listing Codes; Economic and Industry Sectors; Data Item Lists; Function Calculations; Indexes; Index Fundamentals; ISO Currency Codes; Local Market Index Indicator Codes; SIC Codes, GICS codes, and more…

  FAQ’s
  A list of the most Frequently Asked Questions about Research Insight, including specific examples on screening, reporting, formulas and other applications...very helpful!

  Each of the help sub-topics listed above include the following features, or “tabs”:

  | Contents Tab | Works like a table of contents, displaying a list of available topics in on-line Help. |
  | Index Tab | Lets you search the index for a topic. |
  | Find Tab | Lets you perform a full-text search for a word or phrase...extremely useful! |

  Software Demo
  A basic demonstration of the Research and Report Assistant features of Research Insight. More detailed instructions regarding these features are provided later in this document in the “Screening Overview” and “Report Overview” sections.

  Other CompuStat Products
  Provides you with a complete list of Standard & Poor’s Institutional Market Services products

  Welcome to Research Insight
  Opens the Welcome Window, which links you to the main functions of Research Insight, including the innovative and user-friendly “Wizards”. The Research Assistant wizard allows you to search (screen) the COMPUSTAT databases for companies that meet specific criteria. The Report and Chart Assistant wizards allow you to create custom reports and charts.

  About Research Insight
  Displays version and copyright information for Research Insight

Research Insight also allows you to Bookmark and Annotate help topics and definitions. These features can be very helpful and are accessed, respectively, by the menu options Bookmark/Define... or Edit/Annotate....

Additional help is available in Research Insight via the Look Up Tool, detailed further in the section that follows.
• Look Up

The Look Up Tool is accessed via the menu option Tools/ Look Up..., via the toolbar button , or via a Look Up button within various dialogue boxes. The Look Up Tool provides users with the ability, when needed, to “look up” various items used in Research Insight. Select one of the tabs in the Look Up Tool to view lists of Companies, Items and Concepts, Functions, or Sets. The number of tabs displayed will vary, depending on where you are in the software. For example, in Step 1 of the Research Assistant, the Look Up Tool only displays the Company tab.

To search for a company within the Look Up Tool:

Use prefix search by typing the beginning characters of the name you want to find in the Select Companies (or Select Items) field.

You can enter a text string in the Find Text field and Research Insight will display the first name it finds that contains the string anywhere within the name of a company, item or concept, function, or set. Click the Find Next button to find additional occurrences of that text string.

For example, suppose you want to add Aalberts Industries NV, to your screening criteria in the Research Assistant:

1. Beginning in the Look Up Tool, type Aalberts in the Select Companies text box.

   Aalberts Industries NV is highlighted in the list box, and its GVKEY (103413) appears below the list box.

2. Click the Paste button.

   The Look Up Tool pastes the GVKEY into the Companies text box in the Assistant window.

3. Click Close to return to the Assistant window.

◊◊ Note that you can “bookmark” frequently used data definitions as well as help topics and functions.

◊◊
Understanding Time Periods

Compustat assigns fiscal years (defined as an accounting period of twelve months) ending in January through May to the calendar year in which that fiscal year begins. Fiscal years ending June through December are assigned to the calendar year in which the fiscal year ends. The calendar year for each company is the year in which the fiscal year ends. For example, if pulling the year-end data from 1991 to 1995 and one of the comparable company’s fiscal year ends in February, the data from February 1992 to February 1996 will be pulled for comparison. This is done to ensure the closest alignment of operating periods (see below). In this case, the company having the February fiscal year-end would overlap ten months of operating cycle with a December fiscal company for any given year. Also, balance sheet data is only two months off versus what would be ten months if based solely on calendar years.

<table>
<thead>
<tr>
<th>March 1991</th>
<th>February 1992</th>
</tr>
</thead>
<tbody>
<tr>
<td>January 1991</td>
<td>December 1991</td>
</tr>
</tbody>
</table>

- **About the current period**

Current periods change each time data is updated for a new year, quarter, month, or day. Since companies have different fiscal years and reporting time frames, current periods differ among companies. If you do not reference a time period in your applications, you could evaluate formulas for companies with different time periods, especially if you are using both Active (SC) and Research (SR) companies. To avoid this, include a time period reference in the formula or specify the time period when you run a report or screen.

- **Current Period Command - Options Menu**

Use this command to define the current period cutoff for annual, quarterly, monthly, weekly, and daily data. Current period depends on the most recently reported data for a company; you can direct Research Insight how far back in time data is considered current. This can be very important when screening the database, especially when accessing the research population! If you consider current annual data to be within the last five fiscal years, then enter the number 5 in the Annual box. These cutoffs do not affect screens/reports as long as you specify an “absolute” time reference on the item(s) or when running the screen or report.

The example below shows how all cutoffs except Weekly and Daily have been changed to the maximums for the Global database. Enter values to define current period settings for annual, quarterly, monthly, weekly, and daily time periods. The default values for these cutoffs are 3, 6, 3 and 5 respectively.
**Time Period References**

Time period references direct Research Insight to retrieve a data value for a particular point in time other than the current period. If you do not include time period references in your formulas, Research Insight automatically uses the current period (or the most recently available data).

There are three ways to specify the time periods: absolute, relative, and calendar (each discussed below). The issue of Current Period Cutoffs pertains primarily to “relative” time referencing. For example, if you are screening for SALE[Y90] > 100 the issue of cutoff is irrelevant since you are looking at an absolute date/time period of 1990. This is also true if you are using relative time referencing but actually running the screen for an absolute time period. For instance screening on SALE >100,

- **Absolute time period references**

  Absolute references direct Research Insight to an exact fiscal year, quarter, month, etc. If you use an absolute time period reference in a formula, then Research Insight will always evaluate the fiscal time period specified. Below are some examples of absolute time period references:

  - SALE[Y94]
  - SALEQ[Q2Y94]
  - PRCCM[AUG94]

- **Relative time period references**

  Relative references direct Research Insight to evaluate formulas relative to the current time period. The current time period is 0, so the current time period reference is an implied [0]. Therefore, one period prior to the current period is indicated with [-1], two periods prior to the current period is indicated [-2], and so on. Below are some examples of relative time period references:

  - SALE[-1]
  - SALEQ[-3]
  - PRCCM[-4M]

- **Calendar time period references**

  Calendar references direct Research Insight to an exact calendar year, quarter, month, week, or day. The calendar time period is always the exact year in which the time period ends.

  For example, suppose a company's fiscal year-end is May 1997. The calendar time period for annual data is 1997, but the fiscal time period for the same company is different. If you evaluate monthly time periods for annual data ending May 1997, you'll see that seven of the 12 months are from the year 1996. Therefore, the fiscal time period for annual data is 1996. Below are some examples of calendar time period references:

  - Calendar Year  SALE[C97]
  - Calendar Month  PRCCM[JUN97]
  - Calendar Day    CSHTRD[28MAY97]
  - Calendar Quarter SALEQ[IV97]
  - Calendar Week   AJEXW[26W97]

- **Knowing when to use absolute, relative, or calendar time periods**

  Use relative time referencing to create more flexible formulas in your reports, screens, and spreadsheets. For example, suppose you create a monthly report that includes stock performance formulas for the past 12 months using relative referencing. When you evaluate the report, you can specify any beginning month. This gives you the flexibility to display the report for any time period without having to create another report. Using absolute or calendar referencing within a formula always evaluates that formula for the stipulated time period.

  Time periods and periodicity are also important in the alignment of data between companies...it is important to have a basic understanding of these concepts.
• **Specifying time periods when you run a report or screen**

You can specify the time period for which you want your report or screen evaluated by choosing Select Period in the Run Assistant, or a Historical Analysis report in the Report Assistant.

You can specify more than one time period, depending on the type of data in your report or screen. For example, suppose you are evaluating monthly closing price and quarterly common equity. These two data types have different periodicities, monthly and quarterly. You can select a monthly and quarterly time period for the report or screen.

• **Specifying time periods in formulas**

◊◊ Time period references will always be contained within brackets “[ ]”, or will default to the “current” time period if no reference is specified. Always use brackets to specify time references and to enclose period functions when you are building free-form reports or when you are working in the Classic View window, as the following examples indicate:

- SALE[Y96] Returns fiscal 1996 - Sales - Net
- (SALE + SALE[-1]) / 2 Returns the average of current and prior years’ Sales - Net
- PRCCM[@MNT(-1Q)] Returns the Monthly Close Price for the last month of the prior fiscal quarter

NOTE: If a formula is already referenced with an absolute time period (e.g., (SALE[Y94])), then that formula will always return data for the time period specified within brackets, even if you select a different time period when you run a report or screen.

With an understanding of time periods in general, and the Current Period, we are ready to incorporate these concepts into formulas.

For additional information/examples see *Getting Started, Chapter 8 - Understanding Periodicities*

See also in online help:

- @YR - Identify fiscal period year
- @QTR - Identify fiscal period quarter
- @MNT - Identify period month
- @WK - Identify period week
- @DAY - Identify period day
Functions Overview

Functions are predefined calculation tools you can use to perform numerous tasks, from something as simple as averaging data for an industry, to more sophisticated analyses using fractiles. You can use functions in your screening, reporting, spreadsheet, and concept formulas individually, or combine them for more complex analysis. Research Insight provides you with more than 70 functions that allow you to easily and automatically perform data calculations and get complex results fast.

◊◊ The function definitions also provide excellent examples of Research Insight formulas and logic!

- How to construct a function

Every function begins with @, followed by a short name, such as CAVG. Additionally, each function requires instructions for what you want evaluated. We refer to these instructions as arguments and they are always enclosed in parenthesis following the function name (i.e. @CAVG(NI,Y94,Y98) calculates average annual net income from 1994 to 1998).

◊◊ Research Insight categorizes functions by the particular type of analysis you want to perform. For a complete list of functions in each category, along with syntax and descriptions for each, select the Functions tab in the Look Up tool.

- Multiple Regression Functions

These functions allow you to predict the value of a dependent variable (such as a company’s share price) based on its correlation over time with a number of independent variables (for example, Consumer Price Index, Housing Starts, and Price to Book). With the multiple regression functions, you can evaluate and compare the effects of up to 8 independent variables in a time series.

  @MRALPHA  Returns the intercept of the y-axis in the multiple regression equation  
  @MRBETA   Returns the slope of the line for the specified variable  
  @MRTSTAT  Indicates a statistically significant variable  
  @MRFSTAT  Determines whether the observed relationship between the dependent/independent variables occurs by chance  
  @MRCORR   Calculates the correlation coefficient between 3 or more items  
  @MRSTDERR Calculates the standard error of the desired variable

- Set Functions - Calculating Statistics Across Sets

While Research Insight set functions calculate statistics across sets of companies quickly and easily, there are instances where you may want those statistics to be based on a company’s sector or SIC. Let’s say you wanted to compare companies in your current portfolio, but also wanted to compare them across industry sectors and against benchmarks such as the S&P 500. SPRI makes it easy to modify or create new expressions so their statistics are based on your user-defined match criteria.

◊◊ All of the @C functions in Research Insight accept an optional parameter that you can use to base your calculations on and to enhance your analysis. For example, if you want to create a report that compares the Return on Equity (ROE) for companies and then compare them to the a user-defined set ($MYSET) and each company’s respective industry sector, you would use the following expressions in your report:

<table>
<thead>
<tr>
<th>MNEMONIC/EXPRESSION</th>
<th>RETURNS</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROE</td>
<td>Company ROE</td>
</tr>
<tr>
<td>@CAVG(ROE,$SP_500)</td>
<td>Average ROE for S&amp;P 500 companies</td>
</tr>
<tr>
<td>@CAVG(ROE,$SP_500, SECTOR)</td>
<td>Average ROE for S&amp;P 500 companies in same sector as target company.</td>
</tr>
</tbody>
</table>

The last expression calculates an average ROE using the $MYSET, but to base the average on each company’s sector. This report would allow you make several comparisons. All of the set functions in Research Insight accept this new parameter. Research Insight uses this parameter to find other companies that have the same value. And, you can use any data item for this type of analysis. The options are virtually limitless!
• Currency Functions

Currency functions allow you to display data in its native currency and to change units of representation. For example, the @NATIVE function allows you to display data in its native currency, alongside the same data that has been translated in the same report. Use the @SCALE function to change values in any currency to millions, regardless of their units of representation. This applies to those currencies that have characteristically large currency units, such as the Japanese Yen and Italian Lira. Use @ISXE- to determine not available currency data code. This function determines when the exchange rate is not available. If the currency exchange rate is not available the function returns a 1. The @PARM function displays the currency in which data is displayed in your report. If you choose not to translate currency, this function returns "In Native Currency." If you choose to translate data, then that currency description is displayed, such as "In Millions of HONG KONG DOLLARS."

Related Topics in Research Insight:  
Growth functions - Measure growth of a data item over time  
**Historical Analysis functions** - Evaluate data over a period of time  
Logical functions - Return data based on specified conditions  
Mathematical functions - Perform formula calculations  
Period Reference functions - Specify periodicities used to evaluate data  
Screening functions - Transform sets or companies and allows company selection within a set  
**Set Analysis functions** - Evaluate data across a set of companies  
Statistical functions - Return relative standings within a set of companies
Formulas Overview

Although the majority of your analysis can be performed through the Research Assistant, there may be times when you are building a custom report or chart or working in Research Insight’s Classic window when you will want to incorporate formulas and functions. A formula is a mathematical or logical combination of one or more items, concepts, functions, and operators that you can build to extract information from the database or perform a calculation. You can use formulas in Research Insight to create screen criteria, define data in your report or spreadsheet, add date labels to your report or spreadsheet, or create your own “concepts”. For a list of pre-defined concepts see the Compustat Global Data Guide - Appendix A, or use the Look Up Tool for Items under the category “Concepts”.

Formulas may be saved as concepts and given a user-defined name or mnemonic. Concepts are saved to a “user database”, either locally or on your network. For more information regarding user databases please refer to chapters 10 and 11 in Beyond Basics.

Formula Examples

This topic provides you with actual formulas you can create in Research Insight. These are just a sample of formulas that show various combinations of items, functions, parentheses, relational operators, company references, and time period references. You may also copy/cut formulas directly from examples given in data definitions or help files within Research Insight and paste them into your own formula, screen or report.

*Note: After copying some formulas you may need to delete spaces from within, or trailing, the formula. The spaces exist because the formulas are designed for readability, and will produce a “syntax error” when pasted to the formula cell.

Formulas for Screens

*Note: The “$” symbol by itself represents a wildcard placeholder for a company set in the following examples. The formula will use the “base set” in screening or the set being run in a “table” report. This convention for specifying a set is restricted to screening and “table” reports only, not “Freeform” reports.

@PSUM(@IF(REVT>0, 1.0,0),y96,y01)=5

Sums a true/false condition, in this case whether “Revenue-Total” is greater than zero at least five times between 1996 and 2001

TIC=TICI

Finds the primary issue for multiple issue companies. The base set=$FI+$GI.

@AND((@INRANGE(SECTOR,2000,3000)),TIC=TICI)

Finds all issues between Industry Sectors 2000 and 3000. The base set=$FI+$GI.

@AND(CINC="JPN",@INRANGE(SECTOR,8040,8052))

Screens for companies incorporated in Japan, which operate in the computer hardware/software industry sector.

@CSIZE(@SET(@CHGCO(ISSUE),@ISVALUE(PRCCM)))

Screens for all active issues with monthly close prices.

(@RANK(SALE/EMP,$)<=250)

Finds the top 250 companies ranked by sales per employee

Formulas for Reports

@NATIVE(PRCCM)

Displays the monthly closing price in native currency, instead of the currency selected.
SALE[0Y-(@PCOUNT(SALE,-9,0))+1]

Looks back 10 years and uses sales reported at that time. If the company didn’t exist 10 years ago, use sales for the first year on file.

@RANK(ITEM*-1,$)

Reverses the order of @RANK.

@PSUM(@IF((SALE/SALE[-1])>1.1,1,0),-5,0)

Calculates the number of times sales increased by more than 10% in the last six years. This returns a number between zero and six.

@PMAXPD(@AND(@ISVALUE(SALE),@ISNA(SALE[-1])),11,0)

Finds a company’s first year of data.

- **Formulas for calculating decile rankings**

  Note: $MYSET represents a “user-defined” set in the following examples

  \((1-\frac{1}{\text{FRAC} (\text{CR}, \text{MYSET}))} \times 10\)

  Returns decimal values based on Current Ratio where the higher value decile is the best, where the set $MYSET is pre-determined

  \(\text{INT}((1-\frac{1}{\text{FRAC} (\text{CR}, \text{MYSET}))} \times 10)+1\)

  Returns integer values based on Current Ratio where the lower value decile is the best.

  \(\text{IF}(\text{INT}((1-\frac{1}{\text{FRAC} (\text{ITEM},\text{MYSET})})\times 10)<10,\text{INT}((1-\frac{1}{\text{FRAC} (\text{ITEM},\text{MYSET})})\times 10)+1,\text{INT}((1-\frac{1}{\text{FRAC} (\text{ITEM},\text{MYSET})})\times 10))\)

  Calculates decile rankings in tables.

  \(\text{CMIN}(\text{XLR},\text{SET}(\text{MYSET},\text{NTILE} (\text{XLR},10,\text{MYSET})=1))\)

  Calculates bottom value/cutoff of the first decile based upon “Labor and Related Expenses” for a pre-defined set. To calculate the top value for the decile, replace the @CMIN with @CMAX. To get a ranges of all deciles, use =2, =3, etc., to =10 with @CMIN and @CMAX.

- **Formulas for calculating industry/set relatives**

  \((\text{DT/SEQ})/(\text{@CSUM(DT,\text{MYSET},\text{SIC})}/\text{@CSUM(SEQ,\text{MYSET},\text{SIC}))}\)

  When used in free form report, calculates company debt to equity ratio divided by aggregate debt to equity for all companies in a predefined set having the same SIC as the company for which the report is run.

  ♦ Take advantage of the **Report/Define Name...** menu option to replace $MYSET with a prompt for a different base set, providing additional flexibility.

  With a basic understanding of time periods, formulas and functions, we are ready to see how these are used in screening the database and generating reports.

**Related Topics in Research Insight:**
- Creating a formula
- Understanding time periods
- Mixing time periods
- Time period references
Currency Translation

To choose translation options, start from the Tools/Options menu, then select the Currency Translation tab. Use this command to specify the currency translation rate you want to use in your Research Insight session. Currency exchange rates are available only in the Compustat Global database.

Currencies are classified by Research Insight as Tier 1 or Tier 2. Tier 1 currencies can be translated directly into other currencies. Tier 2 currencies are first translated into one of four Primary currencies, then translated from the Primary currency to the target currency. The Currency Translation tab allows you to select from the following options:

- Translated or Native

Your options are:
1. Translate into target currency - translates data into currency you select, for displaying data in reports, charts, and for screening. If you select this option, then indicate the Target Currency and Primary Currency, described below.
2. Use native (as reported) currency - doesn't translate data. Research Insight will perform all operations using the currency in which data is reported.

- Target Currency

This is the currency in which you want data displayed (or converted into).

- Primary Currency

This is the currency to use for the purpose of translating Tier 2 currencies into your Target Currency. Tier 2 currencies do not have a direct translation rate. When your Target Currency does not have a direct translation rate, Research Insight uses the Primary Currency to derive a translation rate. The four Primary Currencies are: British Pounds Sterling (.GBP), Japanese Yen (.JPY), Swiss Franc (.CHF), and United States Dollar (.USD).

For example, suppose you want to translate Papua New Guinea Kinas into Botswana Pulas. Even though there is not a direct translation rate between the Pula and Kina, Research Insight will use a Primary Currency to derive a translation rate. To translate, select BWP (Botswana Pula) for the Target Currency and USD (United States Dollar) for the Primary Currency. Research Insight translates Kinas into US Dollars, and then translates US Dollars into Pulas.
Each Primary Currency reports three translation rate values for every currency in the database. The translation rate value is the number by which a value is multiplied in order to be translated into the target currency. The three exchange rate items are Month Average, Month-end, and 12-Months Moving Average. These items are in the form shown below, where ISO is replaced with the appropriate currency code:

\[
\begin{align*}
X_{\text{ISOAV}} &= \text{Month Average} \\
X_{\text{ISOME}} &= \text{Month-end} \\
X_{\text{ISO12}} &= \text{12-Months Moving}
\end{align*}
\]

For example, XITEMS for British Pounds are: XGBPAV, XGBPME, XGBP12. Research Insight automatically determines which of the three rates to use based on the following rules:

- Point-in-time items, such as Balance Sheet items, are translated using the month-end rate.
- Market items, such as monthly high and low prices, are translated using the month average rate.
- Flow items, such as Income Statement or Statement of Cash Flow items, are translated using the 12-month moving rate.

**Period Translation Rate**

Your options are:
1. Use historical translation rate - translates data using rates for the time period of the item.
2. Use the current translation rate - translates data using current rates for all items, regardless of the time period.

**Description…**

Shows descriptions of the currency codes.

See also in Research Insight: XITEMS - returns mnemonics for currency exchange rate items for Primary and Tier 1 Currencies. UREP - item representing whether the currency displays in units of millions (1) or billions (1000). (available for Month Average Rate, Monthend Rate, and 12-Months Moving Average Rate). CURNM - This is the name of the currency, such as US Dollar or French Franc. @NATIVE(formula) - Displays data in native currency @SCALE(formula) - Returns data in millions @PARM(formula) - This function identifies the translating currency by name in your report. @ISXE(formula) - Determines not available currency data code
Screening Overview

Screening allows users to query the COMPUSTAT database(s) in order to create a set of companies for which data will be generated (see Importing Sets or Set Overview for alternate methods of creating sets). A default “style” is chosen during installation that dictates the items and parameters used by the Research Assistant. Other styles (i.e. Finance, Money Management, Transfer Pricing, or Credit) may be chosen or created using the Tools menu option, then choosing Options... and Styles. Additionally, styles may be modified within the Research Assistant – Step 1 window by using the Customize button.

• Defining Screening Criteria

◊◊ Users may create and run screens using either the Research Assistant or the Open Screen option from the side bar, or by selecting the File and Classic View menu options. The Classic View option is the most flexible in terms of saving and/or accessing interim subsets created as part of the screening process.

The Research Assistant provides an easy method of designing queries without having to know the syntax required for the formula(s). Right-clicking on the “Indicator Item” to be screened allows access to the definition and/or concept chosen. Once the screen has been defined and saved, you may use Open Screen and Classic View to modify it or gain access to subsets.

The “Classic View” facilitates saving or viewing multiple sets from within a single screen.

To screen, or query, the Compustat Global database using the Research Assistant “Wizard”, begin by defining your screening criteria in the Research Assistant - Step 1 window.

1) If your criteria relate to a particular company, enter the GVKEY in the Companies box (separating the keys with commas).
2) To find related companies, choose one of the options under Find Similar Companies (or you can accept the default, Don’t Find Similar Companies).
3) Choose financial criteria from the tabs on the right. Each tab contains a set of related financial indicators. You can select as many indicators as you like for your screen by clicking the box next to the item name. (To de-select an indicator, click the box a second time to remove the check mark.)
4) Choose a mathematical symbol (e.g., <, or >) from the drop-down list. Enter a number or range related to the indicator in the far right field.
5) Choose the subset of the database that your screen will run against by clicking the Change Set button and selecting a set name from the drop-down list. Your screen will run against the set of all Active Industrial and Financial Service companies ($G+$F) by default if no other set is chosen.
6) Click Next and Research Insight screens the database for companies that meet your criteria, and automatically proceeds to the next window where you can view the results of your screen.

• Viewing results and saving sets

After selecting criteria in Research Assistant - Step 1, click Next and you will see a list of the companies that met your screening criteria in the Company List box in Research Assistant - Step 2. If you are satisfied with the list as is, you can save these companies using the Save button to save a new set, or the Save As button to save the set with a new name leaving the original set intact.

To add a company to the list, enter its GVKEY in the Add Company to set box, and click the Add Company button. To remove a company from the Company List, highlight the company name, and click the Remove Company button under the list. Research Insight keeps track of changes you make in the Added Companies and Removed Companies boxes on the right. To restore the original list of companies, click the Reset button in the center of the window.

There may be times when you want to save the screening criteria, or screen, associated with a particular report. For information on saving or associating a particular screen with a report, please refer to the section titled Screen Association on page 14 of this primer.

Another method of creating company sets is to import the GVKEYs, tickers or cusips from existing files, detailed in the next section.

Related Topics in Research Insight: How does Research Insight evaluate the criteria I choose?
Importing Company Sets

Importing sets of companies from an ASCII file into Research Insight is fast and easy! There are *two steps involved in importing your own sets: 1) creating your spreadsheet file and 2) importing the sets from your spreadsheet file into Research Insight.

*Note: Assumes that companies being imported are “known” to the system. If you import private companies, or those not in the population(s) of Research Insight, you would first have to define the company via the Databases and Company... menu options.

◊◊ A timesaving feature alerts you to “unrecognized” GVKEYS, cusips or tickers. When Research Insight encounters an unknown company identifier it will document such in an IMPORTXX.ERR file (XX signifying a number), while continuing to process those that are recognized. The file may be easily printed or SAVED PRIOR TO EXITING RESEARCH INSIGHT.

• Creating your spreadsheet

To create your spreadsheet file, open a new (or existing ) document in your spreadsheet software. Next create the table header, which must contain a retrieval key. Valid retrieval keys include (noting that most foreign companies do not have tickers or CUSIPS and must use GVKEY): Next create the table header, which must contain a retrieval key. Valid retrieval keys include:

| TIC  | The company’s ticker symbol. |
| CUSIP | The company’s CUSIP number. |
| => GVKEY | The company’s GLOBAL Vantage Company Key, a permanent, non-changing key. |
| Currency Code | A currency key used for GLOBAL Vantage. |

We recommend that you save your file as a Comma Separated Values file (*.csv file). Close your spreadsheet application. You are ready to import your set into Research Insight.

• Importing your set

After creating a delimited text file, you are ready to import the set into Research Insight. Begin from the Import dialog box (from the File menu, select Import...):

1. Type the name of the file you want to import in the File Name: text box or select the file from the list box.
2. Select the Set radio button in the Import: text box and click Open, you will be prompted to confirm that the file is comma delimited, click on Yes (The Set Type dialog box appears).
3. Select the type of set that you want to import, normally just accept the default of Company, then Click OK.

A new window will briefly display an import progress bar, the type of retrieval key used, and the items being imported. Research Insight will tell you when the processing is complete. The imported set appears on your screen.

4. Save file as a set. From the File menu, select Save (You’ll see the Save File dialog box). Enter the set name in the File Name: text box. Click OK, Your file is saved as a set.

Once you’ve saved your set of companies and are ready to generate data for these companies, you are ready to run a report. You may use one of the many pre-defined reports available, or you may create your own report/format using the Report Assistant

◊◊ You may also import data/concepts into a “user database”. Please refer to the Beyond Basics manual for more information.

Related Topics in Research Insight: Importing Data
Importing Concepts
Report Overview

A report allows you to generate, view, print, and save/export data for a company or set of companies. You can create your own reports or use one of the pre-defined reports in Research Insight.

- Pre-defined Reports

The Report and Chart Library (Global) provides you with descriptions of predefined reports, including a variety of financial statements and comparative presentations. These reports help you display information as quickly as possible, without having to create a report from scratch.

The Research Insight Compustat Global database differs from COMPUSTAT (North America) with regard to the presentation of data in these predefined, or “canned” reports. The design of each report in Global considers how different companies may present financial data according to different reporting standards and industries. Compustat Global does not attempt to force every company’s data into a single standard format or presentation. The first step in determining the proper report is to identify if the company belongs to the Financial Services populations ($F or $X) or the Industrial populations ($G or $D).

**Industrial companies** income statements are presented according to the most common formats, or models, used internationally. For example, most U.S. companies use the Cost of Sales format (Income Statement Model 1), most German companies use the Purchase or Production format (Income Statement Model 2), and most Hong Kong companies do not breakout their Expense components on their Income Statements (Income Statement Model 4). If you do not need a detailed income statement or balance sheet for an industrial company, you might consider the Key Item Reports, which present major item totals only. For specific model numbers and descriptions refer to the Report and Chart Library (Global) or to the definition for the item “Income Statement Model Number” (ISMOD).

**Financial Service companies’** presentations often depend upon the particular line(s) of business that the company operates in. These companies will have an “Industry Presentation Code” (IPCD) for Banks (B), Broker/Dealer (D), Insurance (I), Real Estate (R), Combined (C), or Other Financial Services (O). The Combined Industry format presents each line of business for a Financial Services company in the same report. For more detailed information refer to the Report and Chart Library (Global) or to the definition for the item “Industry Presentation Code” (IPCD).

A “Balance Sheet Presentation Code” (BSPCD), available for both financial service and industrial companies, identifies a company’s use of either a classified or unclassified Balance Sheet. It also identifies the presence of long-term assets or liabilities in short-term accounts or short-term assets or liabilities in long-term accounts. It consists of a 2-character alpha code. For more detailed information refer to the definition for the item “Balance Sheet Presentation Code” (BSPCD).

A “Level of Consolidation” code (CONSOL), available only for industrial companies, identifies whether a company’s financial statements represent consolidated or non-consolidated information. It consists of a 1-character alpha code. For more detailed information refer to the definition for the item “Level of Consolidation” (CONSOL).
To access a pre-defined report, click **Open Report** in the Welcome window or sidebar, or the **Open Report** icon in the toolbar, and choose from the list of reports categorized by type.

To verify report results and take a quick look at a stream of data, go to **Databases/View/Modify Data**...on the menu bar. Next, enter an Item mnemonic (i.e. PRCCM for Price-Close Monthly) that you wish to view and enter a GV Key, list of GV Keys, or a set and click on View. You are now able to view a stream of data for one company at a time. If you entered more than one GV Key, you can click on Next Co to view additional companies. This feature is valuable for validating results of a screen or report, or simply looking at data quickly, without having to build a report. However, you cannot print from the View/Modify data display.

These pre-defined reports can also help users by providing a good source of formula/expression examples. If an existing report has the type of data you want, such as industry relatives or ratios, you can copy and/or modify the formula for your particular need.
Screen Association

Screen Association allows you to save a particular screen, or the screening criteria, with a report as follows:

From the Tools menu, choose Options. Next, select the Report tab and, under Saving Reports, click the Save Screen association to reports check box. To turn off this option, click the check box again to remove the check mark.

What happens when I select this option? When you close a report, Research Insight will prompt you to save the screen, then the report. With this option selected, Research Insight automatically links the last screen you ran with the report. The next time you open this report, Research Insight will immediately run the report using the associated screening criteria.

What happens when I turn this option off? The software does not save a connection between the screen and the report. The next time you open this report, Research Insight opens the Run Assistant so you can select new screening criteria.

• Exporting/saving report results

The data in the report can also be saved to an ASCII file for use in other application software such as spreadsheet software. To save the data you have generated, begin from the report you have just run:

1. To export your report results, from the File menu, select Save As. You'll see the Save File dialog box.

2. Before saving the file, notice the Text Options... dialog box, which you can use to select column delimiters for your reports. The column delimiter you use depends on the software to which you want to export. The default is to use Tab delimiters, and Labels are not selected. To include labels with your export you must select such. For more information about specific delimiters required by your software program, refer to your specific software manual.

3. Type a file name and click Save (Note that in many universities, you may not have proper permissions to save to the network drive and must first re-direct the file using the Save in: option). The report results are saved with a .txt extension.

• Pre-defined Reports in Microsoft Excel®

One of the most powerful features of Standard & Poor’s Research Insight is its ability to communicate with other active software packages through Active-X technology. This technology allows almost instantaneous communication between Research Insight and Microsoft Excel®. Research Insight is compatible with Excel 97 or greater.

Note: You must turn off the Auto Correct feature in EXCEL to ensure you are retrieving data for the company you have specified. To do so, select Auto Correct from the Tools menu and deselect the Replace Text As You Type option.

◊◊ Users may also create or open existing Research Insight reports (pre-defined or user-defined) directly in Excel, eliminating the need to export data, by using the S&P add-in on the Excel menu. Begin with Excel open:

From the S&P menu, select the Open Report option, you will see the File Open window. Next, select the folder/report you wish to run, then click Finish. You will see the Run Assistant window. Enter your target companies’ GVKEY in the Companies field, separating each GVKEY with commas. (i.e.100944,10553,1004), or the set name. Finally, click OK, and you should see the requested data/report in Excel. To view the report for other companies, select the company from the drop-down list directly above the report. To modify the criteria used to create the spreadsheet, select Run Assistant from the S&P menu.

Although there is no need to export the data, the file actually contains formulas as opposed to raw data. You may save the EXCEL spreadsheet and the Active-X syntax will automatically be saved within the sheet. In order to save the data for use without Research Insight, (i.e. save the file for use at home) users can use the “Unlink Arrays” icon on the EXCEL toolbar or the S&P and Break Arrays menu options. Breaking the arrays produces an additional sheet within the EXCEL workbook containing data only, while maintaining the original sheet/report containing the formulas. This is a great way to learn the Research Insight/EXCEL syntax!

◊◊ In addition to the reports listed in the Report Library, several useful templates have been created for use within EXCEL exclusively. These templates are located in various subfolders under the EXCEL7 or EXCEL8 in the Research Insight directory. One example is the TEAR_GV.XLS in the TPGlobal subfolder.
• **Creating your own reports**

When you create a report, you choose the data you want to display as well as how you want to display it. You can create table reports or free-form reports in the *Report Assistant*. You may also design a free-form report by choosing the Blank Report radio button in Report Assistant - Step 1. The characteristics of each type of report are listed below:

<table>
<thead>
<tr>
<th>Table</th>
<th>Free form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays data for a set</td>
<td>Displays data for a single company or group of companies</td>
</tr>
<tr>
<td>Presents data in columns and rows, with each company's data presented in 1 row</td>
<td>Labels and data can be anywhere in the report, or you can align the data into columns and rows</td>
</tr>
<tr>
<td>Automatically provides default labels for each column</td>
<td>You must add label cells and type labels for data</td>
</tr>
<tr>
<td>Displays Research Insight or user data</td>
<td>Displays Research Insight or user data</td>
</tr>
<tr>
<td>Displays subtotals</td>
<td></td>
</tr>
<tr>
<td>Displays summary statistics</td>
<td></td>
</tr>
</tbody>
</table>

• **Parts of a report**

Whether you create your own report, or use a pre-defined report, one or more of the following elements are found:

- **Cells**
  A cell is the intersection of every row and column, into which you paste or type a formula or label. In *free-form* reports, cells may appear anywhere in the report.

- **Formulas**
  A formula is an item, concept, function, or combination of, and can also include time periods, and relational and mathematical operators.

- **Labels**
  A label is the text that identifies data displayed in your report.

- **Tables**
  A table displays information in columns and rows. It provides you with a title cell to name your report, column labels, and formula cells.

• **Report Assistant**

The Report Assistant is designed to automate and simplify the steps needed for users to create custom reports for data viewing/output. The Report Assistant can be invoked via the Welcome Screen, the sidebar, the *Tools* menu, or from Step 3 of the Research Assistant.

In the *Report Assistant - Step 1* window you can begin building a custom report by defining your report parameters. Define the time period - Research Insight gives you the option of creating a report for the Current Time Period (the most recently available data for the day, month, quarter, or year) or running a Historical Analysis report comparing data items and companies over a specified period of time.

Choose a report format - Select one of the radio buttons under *Current Time Period* or *Historical Analysis* to determine how items, companies, and time periods will display in your report. You will see a preview of the report format you choose in the *Example* window. If you choose a Companies vs. Items report format under Current Time Period, the Company Count box is enabled. You must then select the number of companies that will appear across the top of your report. You may also create a blank template and add/position your own cells by selecting the *Blank Report* radio button.

*Choosing the *Items vs. Companies* produces a Table Report in both scenarios. The remaining options produce Free-form reports, usually the most useful for displaying detailed information for one company record at a time and for “panel” reports.

After choosing your format/parameters, click *Next* to advance to the next window (Step 2) where you will choose the items that will appear in your report.
The Report/Chart Assistant - Step 2 window is used to select items that you want to appear in your report or chart. For your convenience, data items are organized according to Item Groups (e.g. Valuation, Growth, etc.).

Click one of the radio buttons next to an Item Category. You will see that the Items list below changes to show all of the items that are available under that category.

Highlight an item in the list and click the Add button to select it for your report. The item appears in the Selected Items box on the right. If you decide not to include a selected item in your report or chart, highlight the item and click the Remove button.

You can arrange Selected Items in the list in the order you would like them to appear in your report or chart. To do this, select a listed item and change its position in the list with the Move Up or Move Down button.

Additional items and functions can be added to your report or chart by entering the mnemonic in the New Item text box. Then click the down arrow button to add that item to the Selected Items list. If you don’t know the mnemonic, click the Look Up button to search for items and functions.

◊◊ You can also customize the Item Categories to include the items that you use most often.

After you have chosen the items for your report or chart, if you chose a Historical Analysis report, click Next to advance to the next step in the Report or Chart Assistant. If you chose a Current Period report, click Finish to run your report or chart.

The Report/Chart Assistant - Step 3 window appears only when you have chosen a Historical Analysis report or chart. It allows you to select a time period format as well as the beginning and ending time periods. It also lets you align items with different periodicities so that they appear on the same period basis.

Select one of the three Time Period Formats - Relative for the year, quarter, month, week, or day relative to the current period; Absolute for the exact year, quarter, month, week, or day; or Calendar for a calendar year, quarter, month, week, or day.

Use the arrow buttons to choose the Beginning Period and the Ending Period for your report or chart. The following are some examples of beginning and ending periods for each time period format:

<table>
<thead>
<tr>
<th>Beginning Period</th>
<th>Ending Period</th>
<th>Time period returned in your report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative</td>
<td>-1Y</td>
<td>0Y</td>
</tr>
<tr>
<td>Absolute</td>
<td>Y96</td>
<td>Y97</td>
</tr>
<tr>
<td>Calendar</td>
<td>Y96</td>
<td>Y97</td>
</tr>
</tbody>
</table>

Choose one Alignment for each data item/periodicity in the report or chart. For example, if you selected a data item with an annual periodicity (like Revenue - Total) and an item with a monthly periodicity (like Market Value), then the annual and the monthly alignment options will both be enabled. If you choose monthly, then Research Insight calculates the annual item on a monthly basis, and returns a monthly Sales figure as well as the monthly Market Value.

Users may want to use period reference functions in their formulas, allowing the ability to change the time period associated with an item. For example, you can change the time reference for a monthly item to an annual time period using the @MNT function such as PRCCM@MNT(0Y). Other *period reference functions are: @DAY - Identify period day, @PERIOD - Display period number, @QTR - Identify fiscal period quarter, @WK - Identify period week, @YR - Identify fiscal period year.

Note that the Global database currently contains annual and monthly data only, but can accommodate other periodicities.
Custom “Panel” Reports for SAS

Many users prefer to create their own reports for exporting data into ASCII files, which can then be used with other software for analysis. Research Insight provides the ease of use and flexibility to accommodate the needs of such users. A free-form report, as opposed to a table report, generally gives the user more control over the basic layout of the report for such applications. Keep in mind that free form reports, by default, will generate one record per company in the same file. In the case of spreadsheet software, such as Excel, the records will appear one after another in subsequent rows of your spreadsheet (Any labels included in the report will be duplicated between records, so many users choose to add labels after saving the data).

Include the item GVKEY with any reports, in addition to TIC or CUSIP, as this is a permanent company identifier for Research Insight companies.

The following are two possible methods of creating a free form “panel” report. Method 1 potentially requires more keystrokes and manipulation than Method 2, in that the user is required to create and align every cell into rows and columns. Method Two automates the creation of rows and columns and formula creation/input, but the user may end up deleting some labels and cells to create a finished report (Most faculty would probably do best by using Method Two). Begin in the Report Assistant - Step 1 window.

Method 1
Selecting the Blank Report radio button, then selecting the Finish option will provide a blank report template. The user must then select either the “@” or “T” toolbar options to add/position formula or text cells. Once the cells have been added, input the formula or label for the respective cells. Be sure to take advantage of the copy, paste, and Edit/Replace... features of the software to minimize keystrokes and effort.

Method 2
Define the basic layout for your report by selecting the radio button Items vs. Time for Companies or Time vs. Items for Companies in the Historical Analysis box. This choice defines whether you have items/time periods going vertically or horizontally in the finished report. After choosing your format/parameters, click Next> to advance to Step 2 and choose the items that will appear in your report. You can choose multiple items as in the following example, or select a single item then use the copy, paste and find/replace functionality of Research Insight to add additional cells and items. Once you have chosen your items, click Next> to proceed to Step 3 and select the time periods for which you need data. At this stage, clicking Finish will bring up the Run Assistant window. Click Cancel to remain in the template without processing.

You can now delete the extraneous items that you may not want, such as company name and labels, and modify as in Method 1 (i.e. using copy, paste and find/replace). The following is an example of using the Report Assistant simply selecting the annual item Sales, Net Income and Pretax Income for a five-year period.

Above: Results of using Report Assistant, Items vs. Time for a Company, and selecting Sale for five years of data.
**Below:** Highlight the cells to delete (exporting the data creates an ASCII file with each record following the previous). To highlight simply click on the “CONM” formula cell, hold your *Shift* key and click on the “Net Income (Loss)” label cell, then hit *Delete* key.

If you decide that you want additional items or years, use the copy, paste and Edit/Replace options within Research Insight to modify the report. The example below shows how to add a column for Earnings per Share (EPSPX), Global Vantage Key (GVKEY) to the end of the report above, once the extraneous cells have been deleted.

**Above:** After deleting unwanted cells, copy the “sale” column by a) highlighting the cells, b) choosing *Edit/Copy* then *Edit/Paste* from the menu (or use the toolbar copy and paste) and, c) use the *Edit/Replace* and *Replace Select* (so that only the highlighted cells are replaced) to replace Sale with the additional items you need.
Note that in example below the last column contains the item GVKEY. This was not input using the Replace option, but instead just typed after highlighting the cells. This is because GVKEY is a “scalar” item and will not function with time references. Further, GVKEY is input several times simply for company / data identification and alignment of data once exported to a spreadsheet.

- **Table “Panel” Reports**

An alternate format for creating panel reports is to use the Report Assistant, choosing the default *Current Time Period* and Items vs Companies as shown below. This format is often preferable when data is needed for large sets of companies as it does not require the program to access an entire company record, instead only accessing the items requested of that record. This can be beneficial in terms of “speed” of both generating and exporting the data requested.

Continue to Step 2 of the Report Assistant by clicking on Next to select the items you require in your report as described previously in this document. Once you have finished selecting the items choose Finish to run and/or save your report. If you wish to modify the report at any time, simply open the report to add/delete columns, change data items/formulas or make other formatting changes such as data sort orders.

You must run this report multiple times to generate data for multiple years since it is defined to run for the “Current Time Period” only. This is done by selecting the Report Time Periods folder, as shown on the following page, and choosing the Select Period option to specify the

*You may choose “Historical Analysis” as opposed to “Current Time Period” to get multiple years of data in a single report, but many users have indicated that this presents a problem for third-party software packages as it lists the items multiple times across the top of the report.*
• Charts

Research Insight provides you with an extensive collection of pre-defined charts to help you bring your financial analysis to life. This collection includes the most commonly used charts for both the COMPUSTAT (North America) and Compustat Global databases. You may also create your own charts using the Chart Assistant. This powerful tool will guide you, step by step, through the chart-building process. And, if you only want to chart a few items from your report, you can do that too.

Once you have selected the data you want to display and determined how you want to display it, you can customize your chart attributes. You can change the chart style, colors, and axis labels. You can also add titles, change fonts, and customize the legend. You can even change a two-dimensional chart to a dynamic three-dimensional chart. The possibilities are endless!

Charts are actually created via the Chart Assistant in much the same way as are reports via the Report Assistant. For detailed information regarding charts please refer to the Research Insight program help facilities. One thing to keep in mind is that once you have created a chart within Research Insight, clicking on the camera tool in the upper right corner copies the chart to the clipboard. Once in the clipboard, it may easily be pasted into other programs/documents such as Word, Excel and PowerPoint.

Related Topics In Research Insight:
- Creating a Free form Report
- Creating a Table Report
- Customizing the Appearance of Your Report
- Running, Printing, and Exporting a Report
- Viewing report results for multiple companies
- Choose a chart style
- Changing your chart attributes
- Changing your chart criteria
- Creating a Chart From a Free-Form Report
- Working with charts in Excel

For more information regarding Standard & Poor’s Investment Services products and services visit our web site at [http://www.compustat.com/support](http://www.compustat.com/support), or refer to Other Compustat Products in the Research Insight Help menu option.